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IMPORTANT NOTICE 
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Database functions MUST be installed on the same computer. It is also 
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1.0 PRODUCT DESCRIPTION 

siteVIEW Enterprise Edition by TASC Systems Inc., is a computer program 
for monitoring and controlling networks of siteCOMMANDER hardware 
units. The software runs on Windows ™-compatible personal computers.  

siteVIEW Enterprise Edition is made up of three software 
components(diagram):  

User Interface – provides the Operator with a customizable graphical view 
of a network of siteCOMMANDER units. This allows the Operators to 
monitor and control remote sites. 

Data Warehouse – stores the configuration, communication, events and 
alarms between the siteCOMMANDER network and the User Interface. 
Can be viewed as a “Post Office” sorting, and storing communications for 
the siteVIEW Server for the User Interface(s). 

Communication Server - communicates with a remote network of 
siteCOMMANDER hardware units via a siteCOMMANDER configured as a 
Gateway. Data collected from the remote siteCOMMANDERs is saved by 
the database service. 

 

Local Area Network

Communication Server
Data Warehouse

User Interface

These three components of the siteVIEW
Enterprise system can reside on a single
computer or be distributed amongst multiple
computers

 

Figure  1 – Computer Configuration 

The three system components can run on a single computer or on as many 
as three separate computers. Generally, multiple computers are needed in 
larger systems where performance is a concern. If there are multiple users 
on a network, each user will need a computer running the User Interface. 

 



TASC siteVIEW Enterprise Edition – Quick Start Guide 

TASC Systems Inc.  Page 2 of 13 
All Rights Reserved. 

1.1 System Requirements 

User Interface 
Processor:  Pentium III 600MHz 
Memory:  128MB RAM 
Hard Drive:  10GB 7200RPM,  100 MB free space 
CD ROM:  52x CDROM 
Network Card:  10/100 Ethernet Card 
Monitor:  17” VGA Monitor 
Video Card:  32MB PCI /AGP2x Video Card 
Mouse:  USB/PS2 Mouse 
Keyboard:  Standard 100/101 Keyboard 
Operating System: Microsoft Windows 2000/XP 

Communication Server 
Processor:  Pentium III 866MHz 
Memory:  256MB RAM 
Hard Drive:  10GB 7200RPM, 500 MB free space 
CD ROM:  52x CDROM 
Network Card:  10/100 Ethernet Card 
Serial Ports:  Minimum One  (connection to Gateway Unit) 
USB Ports:  One USB 1.1/2.0 (for license key) 
Operating System: Microsoft Windows 2000/XP 

Data Warehouse 
Processor:   Pentium III 866MHz 
Memory:  512MB RAM 
Hard Drive:  20GB 7200RPM, 500 MB free space 
CD ROM:  52x CDROM 
Network Card:  10/100 Ethernet Card 
Operating System: Microsoft Windows 2000/XP 
 
 
Note: In a single-computer system, the requirements are the same as 
for the Data Warehouse plus an additional 500 MB of hard drive 
capacity. 
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2.0 INSTALLING SITEVIEW ENTERPRISE 
Prior to installing siteVIEW Enterprise Edition, it is important to decide 
whether you will be using siteVIEW Enterprise in a client/server 
environment or in a single machine environment. As described above, it is 
possible to install the client, server and database on the same machine or 
on separate machines. 

2.1 Installing Onto Multiple Computers (Client/Server 
Model) 

2.1.1 On the User Interface Computer: 
1. Insert the siteVIEW Enterprise CD into the CDROM drive.  

2. The auto-run menu should appear automatically. (If it doesn’t, use 
Windows Explorer to locate the file named “setup.exe” on the CD-ROM 
then double-click to start the install then proceed to step 4). 

3. Click on “Install siteVIEW Enterprise” 

4. Click Next at the Welcome Screen 

5. A menu will be displayed showing the different siteVIEW Enterprise 
components.  

6. Ensure that only “siteVIEW Enterprise User Interface” is checked 

7. Click Next 

8. After the installation is complete click Close. 

9. The siteVIEW Enterprise User Interface Icon should now be visible on 
your desktop and available from the TASC Programs Group  

10. Reboot the PC to complete the installation. 

2.1.2 On the Communication Server / Data Warehouse Computer: 
1. Insert the siteVIEW Enterprise CD into the CDROM drive. 

2. The auto-run menu should appear automatically. (If it doesn’t, use 
Windows Explorer to locate the file named “setup.exe” on the CD-ROM 
then double-click to start the install then proceed to step 4). 

3. Click on “Install siteVIEW Enterprise” 

4. Click Next at the Welcome Screen. 

5. A menu will be displayed showing the different siteVIEW Enterprise 
components. 

6. Ensure that only “siteVIEW Enterprise Communication Server” is 
checked and click Next. 

7. After the installation is complete click Close. 

8. Reboot the computer
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9. After rebooting the PC, navigate to the Data Warehouse folder (default 
is: C:\ Program Files\TASC\siteVIEW Enterprise Edition\Communication 
Service) Single-click on the “DataWarehouse” folder to highlight it. 
Under the File menu, select Sharing, share the folder and then click 
Apply and OK.  

 

NOTE: It is important that the shared Data Warehouse folder have the 
correct permissions for client machines to gain proper access to it. 

2.2 Installing Onto a Single Computer 

1. Insert the siteVIEW Enterprise CD into the CDROM drive. 

2. The auto-run menu should appear automatically. If it doesn’t, use 
Windows Explorer to locate the file named “setup.exe” on the CD-ROM 
then double-click on the file name to start the install. 

3. A menu will be displayed showing the different siteVIEW Enterprise 
components. 

4. Ensure that both the siteVIEW Enterprise User Interface and the 
siteVIEW Communication Server are checked.   

5. Click Next 

6. After the installation of each of the components is complete, click on 
Close. 

7. The siteVIEW Enterprise User Interface Icon should now be visible on 
your desktop and from the TASC Programs Group  

8. Please Reboot your PC to complete the installation 
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3.0 CONFIGURING SITEVIEW ENTERPRISE 
This section highlights how to start the Client Workstation and set up a 
basic configuration. More advanced information is available in the siteVIEW 
Enterprise Edition User Manual.  

To get started, launch the siteVIEW Enterprise User Interface from either 
the desktop icon or through the TASC programs group (via the Windows 
Start bar). Take a moment to familiarize yourself with the siteVIEW 
Enterprise User Interface.  

Site Panel
Where Monitoring
and Control Take
Place

Communications
Where communications
are viewed / managed

Alarms
Where Alarms are
viewed / managed
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Figure  2 – User Interface Opening Screen 
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3.1 Connecting to the Data Warehouse  

3.1.1 Single Computer Model 
 
The Data Warehouse connection is automatically established for the single 
computer environment. You will therefore be required to sign-in immediately after 
launching the siteVIEW Enterprise User Interface. 
  

Username: svadmin 
 Password: siteVIEW 
 
*The default password should be changed as soon as possible for security 
purposes. 

3.1.2 Client Server Model 
1. Using the “Connect” menu, select “Connect to Database.” 

2. Locate the siteVIEW Server folder that you shared earlier when setting 
up the computer. 

3. Click the “Open” button 

4. You will be prompted for a Username and Password to access the 
database. Default* account:  

5. Username: svadmin 

6. Password: siteVIEW 

7. *The default password should be changed as soon as possible for 
security purposes. 

8. You are now ready to configure a Communication Port that is 
connected to either a gateway siteCOMMANDER or Kenwood 
Fleetsync Radio. 

3.2 Configuring a Communication Port 

1. In the Tree View pane, select the siteVIEW Server, click on the “Edit” 
menu and select “New COM Port”. This will create a new port on the 
siteVIEW server; this port is connected to your gateway 
siteCOMMANDER or Kenwood Radio Gateway. 
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Figure  3 – Port Configuration Window 

2. Type in a meaningful Name and Description for your siteCOMMANDER 
network. 

 

Figure  4 – Port Name and Description 

3. Select the appropriate physical COM port, communication protocol and 
protocol settings in the dropdown boxes. 

  

Figure  5 – Protocol and Physical Port Configuration 

4. Click “Finish” and your new Communication Port will now be available.
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3.3 Configuring a siteCOMMANDER (Device) 

1. Ensure that every siteCOMMANDER in your network is connected 
appropriately to the inputs to be monitored and to the outputs to be 
controlled. 

2. Left Click, in the Tree, on the Communication Port that you previously 
configured to select it. From the “Edit” menu, select “New Device”. 

 

Figure  6 – Device Configuration Window 

3. Type in a meaningful Name and Description for this device.  

 

Figure  7 – Device Name and Description 

4. Set the initial siteCOMMANDER transport medium, network role and 
address. These settings define which device on your network you’re 
trying to establish communication with. 
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Figure  8 – Configure Device Connection Settings 

5. Click on “Finish” to read the configuration from the device 
(siteCOMMANDER).  

6. After the read of the device configuration is complete you are now ready 
to configure the screen elements fro the device and the user accounts. 

3.4 Modifying the Screen Layout 

Once a device has been configured appropriately, you are ready to 
configure the screen layout for that particular device. 

The network is represented as a hierarchical tree with individual 
siteCOMMANDERs at the lowest levels. It is possible to configure a Site 
Panel for all three levels of the tree; the Server level, the Port level and the 
Device level.  

Any graphical I/O or site representation that exists on the Site Panel is 
referred to as an element.  

 

Figure  9 – Tree View 
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The following is an example of how to configure the  Server Level: 

1. In the “Tree”, highlight the Server level. 

2. A default element can be seen in the top left of the “Panel” area. This 
element represents a Communication Port on the Server (Clicking this 
element will move you to the Communication Port level when in the 
Lock State).  

3. To edit the Server Level click on the “Edit” menu, select “Site Panel” 
and then “Unlock Panel”. This will allow you to configure the element(s) 
on this panel. 

 

Figure 10 – Unlocking the Panel 

4. Left click on the default element and notice the configuration form, 
which appears. On this form you can alter the type and look of the 
element. Make the desired changes and then click the “Close” button. 
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Figure 11 – Element Properties Window 

5. Moving and resizing an element is accomplished by hovering the 
mouse over various parts of the element-sizing square until the cursor 
changes to the appropriate adjustment arrow. A four-headed arrow 
indicates you can move the element. A two-headed arrow indicates that 
you can resize the element. For example, it if a map is displayed as a 
background, the element can be moved a sized to represent a physical 
location on the map background. 
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Figure 12 – Resized Element 

6. After completing the necessary modifications of the Server panel, lock 
the panel by selecting the “Edit” menu, “Site Panel” and then select 
“Lock Panel” 

 

Figure 13 – Locking the Panel 

7. The above steps can be repeated on all levels of the tree. You may now 
continue to configure the Port level and the Device level. 

3.5 Configuring siteVIEW Enterprise Security 

During the installation of siteVIEW Server, a default administration account 
is created. The default account provides the system installer or 
administrator with the ability to create, modify and delete user accounts of 
varying security levels. 
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The default administration account is: 

 Username: svadmin 

 Password: siteVIEW 

It is recommended that you change the password for the administration 
account as soon as possible. It is recommended that the administration 
account not be used for the day-to-day operation of a system. 

3.5.1 Creating New User Accounts 
To create a new user account, navigate to the “Connect” menu and select 
“Accounts” then select “User Administration”. This will bring up the User 
Administration form. Simply select “New” and fill in each entry location with 
the appropriate information.  

The First name and Last name fields are used to ensure proper association 
to an actual user. This allows for easy maintenance of the users. The 
Username field is the logon name that will have to be entered by a user for 
the given account. 

The Password field is used to provide a level of security for each account. 
The password field is hidden from view during entry, can accept up to 50 
characters and can be left blank if so desired.  

 

The User Rights field lets the administrator assign four levels of permission 
for a user account. The following is a list of the available permissions within 
siteVIEW Enterprise: 

 

• View Only:  The user can only monitor the operation of the 
system (view alarms, events, history). No ability to edit, configure or 
send output commands to any devices. Also, no ability to edit the 
user interface of the User Interface, make any scheduling changes 
or modify the user accounts. 

• User:   Same as View Only, with the addition of the ability to 
control (i.e. send output commands to) devices on the network. 

• Power User: A user at this level can monitor, control, edit and 
configure devices on the network. The user is also able to change 
schedules and edit the user interface. The user is unable to 
configure user accounts. 

• Administrator: A user at this level can perform all functions. This 
user has complete control over the system and all of its devices as 
well as the ability to create, edit and delete user accounts 

Select the appropriate level of permission for the operator and then ensure 
the “Enable” check box has been checked. Finally, create the user account 
by clicking the “Add” button. The newly created account and its associated 
information will appear directly to the left. 


